
Surface-based Group Analysis
in FreeSurfer
based Group Analysis
in FreeSurfer



Outline

• GLM Theory 
• FSGD File 
• Processing Stages
• Vertex-wise Analysis• Vertex-wise Analysis
• Correction for multiple comparisons
• Interactive/Automated GUI (QDEC)

Outline

wise Analysis
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wise Analysis
Correction for multiple comparisons
Interactive/Automated GUI (QDEC)



Surface-based Study (Thickness)based Study (Thickness)

3



Surface-based Measures

• Morphometric (eg, thickness)
• Functional
• PET
• MEG/EEG• MEG/EEG
• Diffusion (?) sampled just under the 

surface

based Measures

Morphometric (eg, thickness)
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Diffusion (?) sampled just under the 



Intersubject RegistrationIntersubject Registration
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Coordinate Systems: 3D (Volumetric)

• 3D Coordinate System 
• XYZ
• RAS (Right-Anterior-Superior)
• CRS (Column-Row-Slice)
• Origin (XYZ=0, eg, AC) • Origin (XYZ=0, eg, AC) 
• MR Intensity at each XYZ

Coordinate Systems: 3D (Volumetric)

Superior) x

y
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Coordinate Systems: 2D (Surface)

central

sylvian

anterior

posterior

Sheet: 2D Coordinate System (X,Y)

x

y

superior temporal calcarine

pial inflated

Coordinate Systems: 2D (Surface)
Sphere: 2D Coordinate System 
• Latitude and Longitude (q, f)
• Continuous, no cuts
• Value at each point (eg, thickness)

f
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inflated

Curvature 
• SULCUS (+)
• GYRUS (-)

q

f



Volumetric Intersubject Registration

• Affine/Linear 
• Translate
• Rotate
• Stretch
• Shear
• (12 DOF)• (12 DOF)

• Match Intensity, Voxel-by-Voxel
• Problems
• Can use nonlinear volumetric (cf CVS)

Volumetric Intersubject Registration
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Voxel

Can use nonlinear volumetric (cf CVS)



Surface-based Intersubject Registration
Subject 1

• Translate,  Rotate,  Stretch,  Shear (12 DOF)
• Match Curvature, Vertex-by-Vertex
• Nonlinear Stretching (“Morphing”) allowed (area regularization)
• Actually done on sphere
• “Spherical Morph” 

based Intersubject Registration
Subject 2

Curvature “Intensity”
• SULCUS (+)
• GYRUS (-)
• Codes folding pattern

9

Translate,  Rotate,  Stretch,  Shear (12 DOF)
Vertex

Nonlinear Stretching (“Morphing”) allowed (area regularization)



Surface-based Intersubject Registration

• Gray Matter-to-Gray Matter (it’s all gray matter!)
• Gyrus-to-Gyrus and Sulcus
• Some minor folding patterns won’t line up
• Fully automated, no landmarking needed• Fully automated, no landmarking needed
• Atlas registration is probabilistic, most variable 
regions get less weight.
• Done automatically in recon

based Intersubject Registration

Gray Matter (it’s all gray matter!)
Gyrus and Sulcus-to-Sulcus 

Some minor folding patterns won’t line up
Fully automated, no landmarking needed
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Fully automated, no landmarking needed
Atlas registration is probabilistic, most variable 

Done automatically in recon-all 



GLM Theory: Design Matrix

y11
y12
y13
y21
y22

G1    G2       G1*Age    G2*Age

1   0       20       0
1   0       25       0
1   0       30       0
0   1         0     18
0   1         0     23

=
y22
y23

0   1         0     23
0   1         0     35

Data     Design Matrix       Regression Coefficients

y = X*b

GLM Theory: Design Matrix

G1    G2       G1*Age    G2*Age

1   0       20       0
1   0       25       0
1   0       30       0
0   1         0     18
0   1         0     23

b1
b2
m1
m2
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0   1         0     23
0   1         0     35

Data     Design Matrix       Regression Coefficients

b



GLM Theory: Contrasts

y11
y12
y13
y21
y22

G1    G2       G1*Age    G2*Age

1   0       20       0
1   0       25       0
1   0       30       0
0   1         0     18
0   1         0     23

=
y22
y23

0   1         0     23
0   1         0     35

CGroup = [1 -1      0    0]   Group diff=0?

CAge =   [0  0    0.5 0.5]  Mean slope=0?

CGroupXAge =   [0  0    +1   

GLM Theory: Contrasts

G1    G2       G1*Age    G2*Age

1   0       20       0
1   0       25       0
1   0       30       0
0   1         0     18
0   1         0     23

b1
b2
m1
m2
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0   1         0     23
0   1         0     35

1      0    0]   Group diff=0?

=   [0  0    0.5 0.5]  Mean slope=0?

=   [0  0    +1   -1] Group/Age InterX?



Vertex-wise Analysis and Inference

y = X*b+e
b=(XtX)-1Xty
g=C*b

t 


p-value/significance
• value between 0 and 1• value between 0 and 1
• closer to 0 means more significant
FreeSurfer stores p-values as 
• 0.1=10-1sig=1, 0.01=10
• sig.mgh files

• Signed by sign of g
• p-value is for an unsigned test

wise Analysis and Inference

TT CXXC

C
12 )(*

*



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closer to 0 means more significant
values as –log10(p):
0.01=10-2sig=2

value is for an unsigned test



Need:

1. X (Design Matrix)
2. C (Contrast Matrix or Matrices)
3. y (Data)

Need:

C (Contrast Matrix or Matrices)
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Specifying X and C

1. Manually create X 
• Manually create C

2. FSGD file – text editor
• FreeSurfer creates X
• Manually create C• Manually create C

3. QDEC – spread sheet, etc
• FreeSurfer creates X and C

Specifying X and C

Manually create X – text editor
Manually create C

text editor
FreeSurfer creates X
Manually create C
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Manually create C
spread sheet, etc

FreeSurfer creates X and C



FreeSurfer Group Descriptor (FSGD) File

• Simple text file (ascii, clear text)
• List of all subjects in the study
• Accompanying demographics

FreeSurfer Group Descriptor (FSGD) File

Simple text file (ascii, clear text)
List of all subjects in the study
Accompanying demographics
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FSGD Format
GroupDescriptorFile 1
Class Male
Class Female
Variables                         Age  Weight   IQ
Input bert Male          10      100   1000
Input fred Male          15      150   1500
Input jenny Female      20      200   2000
Input margaret Female      25      250   2500
Input jenny Female      20      200   2000
Input margaret Female      25      250   2500

• One Discrete Factor (Gender) with Two Levels (M&F)
• Three Continuous Variables: Age, Weight, IQ
• $SUBJECTS_DIR/bert

FSGD Format

Variables                         Age  Weight   IQ
Male          10      100   1000
Male          15      150   1500
Female      20      200   2000
Female      25      250   2500

17

Female      20      200   2000
Female      25      250   2500

One Discrete Factor (Gender) with Two Levels (M&F)
Three Continuous Variables: Age, Weight, IQ



FSGD X (Automatic)

1  0  10 0  100   

1  0  15 0   150   

0  1  0   20  

0  1  0   25   

X =

Male Group

Female Group Male*Age

DODS – Different Offset, Different Slope

C =       [-1 1    0     0         0       0           0         0]

Tests for the difference in intercept/offset

0  1  0   25   
Age

C =       [ 0  0    -1   1          0       0           0         0]
Tests for the difference in age slope

X (Automatic)

100   0 1000    0 

150   0   1500   0 

0   200  0    2000 

0   250  0    2500 

Female*Age

Male*Age
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1 1    0     0         0       0           0         0]

intercept/offset between groups

0   250  0    2500 
Weight IQ

1   1          0       0           0         0]
age slope between groups



FSGD Terminology
Continuous Variables/Factors

Discrete Variables/Factors: Gender, Handedness, Diagnosis
Levels of Discrete :

Handedness: Left and Right
Gender: Male and FemaleGender: Male and Female
Diagnosis: Normal, MCI, AD

Cannot specify Discrete Factors in FSGD

Group or Class: Specification of All Discrete Factors:
• Left-handed Male MCI
• Right-handed Female Normal

FSGD Terminology
Continuous Variables/Factors: Age, IQ, Volume, etc

: Gender, Handedness, Diagnosis

Handedness: Left and Right

19

Diagnosis: Normal, MCI, AD
Cannot specify Discrete Factors in FSGD

: Specification of All Discrete Factors:

handed Female Normal



Number of Regressors

Each Group/Class:
• Has its own Intercept
• Has its own Slope (for each
continuous variable)continuous variable)

NRegressors = NClasses*(NVariables+1)

Number of Regressors

Has its own Intercept
Has its own Slope (for each

continuous variable)

20

continuous variable)

NRegressors = NClasses*(NVariables+1)



Data (y): Thickness Study

1. $SUBJECTS_DIR/bert/surf/lh.thickness
2. $SUBJECTS_DIR/fred/surf/lh.thickness
3. $SUBJECTS_DIR/jenny/surf/lh.thickness
4. $SUBJECTS_DIR/margaret4. $SUBJECTS_DIR/margaret
5. …

Data (y): Thickness Study

/surf/lh.thickness
/surf/lh.thickness

/surf/lh.thickness
margaret/surf/lh.thickness

21

margaret/surf/lh.thickness



--fsgd    FSGDFile : Specify subjects thru FSGD File

--hemi  lh : Process left hemisphere

--meas thickness : $SUBJECTS_DIR/subjectid/surf/hemi.thickness

--target fsaverage

Assemble Data: mris_preproc
mris_preproc --help

--target fsaverage : common space is subject fsaverage

--o lh.thickness.mgh : output “volume

Lots of other options!

lh.thickness.mgh – file with thickness maps for 
all subjects  Input to Smoother or GLM

See also: recon-all -qcache

: Specify subjects thru FSGD File

: Process left hemisphere

: $SUBJECTS_DIR/subjectid/surf/hemi.thickness

Assemble Data: mris_preproc

22

: common space is subject fsaverage

: output “volume-encoded surface file”

file with thickness maps for 
Input to Smoother or GLM



Spatial Smoothing

Why should you smooth?
• Might Improve CNR
• Improve intersubject registration (functional)

How much smoothing?
• Blob-size
• Typically 10-20 mm FWHM 
• Surface smoothing more forgiving than volume

Spatial Smoothing

Improve intersubject registration (functional)

23

20 mm FWHM 
Surface smoothing more forgiving than volume-based



Volume-based Smoothing

7mm FWHM

14mm FWHM

based Smoothing

• Smoothing is 
averaging of nearby 
voxels
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Volume-based Smoothing

14mm FWHM

based Smoothing

• 5 mm apart in 3D
• 25 mm apart on surface!
• Kernel much larger
• Averaging with other 
tissue types (WM, CSF)

25

tissue types (WM, CSF)
• Averaging with other 
functional areas



Surface-based Smoothing

Sheet: 2D Coordinate System (X,Y)

• Smoothing is averaging 
of nearby vertices

superior temporal calcarine

central

sylvian

anterior

posterior

Sheet: 2D Coordinate System (X,Y)

based Smoothing

Sphere: 2D Coordinate System (q,f)

26

Sphere: 2D Coordinate System (q,f)



Surface Smoothing

• mri_surf2surf --help

• Loads lh.thickness.mgh 

• 2D surface-based smoothing 

• Specify FWHM (eg, fwhm = 10 mm)

• Saves lh.thickness.sm10.mgh

• Can be slow (~10-60min)

• recon-all -qcache

Surface Smoothing

based smoothing 

27

Specify FWHM (eg, fwhm = 10 mm)

Saves lh.thickness.sm10.mgh

60min)



Estimation and Inference: mri_glmfit

• Reads in FSGD File and constructs X 

• Reads in your contrasts (C1, C2, etc)

• Loads data (y=lh.thickness.sm10.mgh)

• Fits GLM (ie, computes b
• Computes contrasts (g=C*

• t or F ratios, significances 

• Significance -log10(p) (.01 

Estimation and Inference: mri_glmfit

Reads in FSGD File and constructs X 

Reads in your contrasts (C1, C2, etc)

Loads data (y=lh.thickness.sm10.mgh)

b)

28

=C*b)

t or F ratios, significances 

log10(p) (.01  2, .001  3)



mri_glmfit

mri_glmfit 
--y lh.thickness.sm10.mgh 
--fsgd gender_age.txt
--C age.mat –C gender.mat--C age.mat –C gender.mat
--surf fsaverage lh
--cortex
--glmdir lh.gender_age.glmdir

mri_glmfit --help

mri_glmfit

Creates: lh.gender_age.glmdir/ 
beta.mgh – parameter estimates
rvar.mgh – residual error variance
etc …
age/ 
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age/ 
sig.mgh – -log10(p), uncorrected
gamma.mgh, F.mgh

gender/ 
sig.mgh – -log10(p)
gamma.mgh, F.mgh



Visualization with tksurfer

Threshold:
-log10(p),
Eg, 2=.01

File->LoadOverlay

Visualization with tksurfer
Saturation:
-log10(p),
Eg, 5=.00001

False
Dicovery

30

View->Configure->Overlay

Dicovery
Rate
Eg, .01



Visualization with tksurfer

File->
Load Group Descriptor File …

Visualization with tksurfer
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Load Group Descriptor File …



Problem of Multiple Comparisons

p < 0.10 p < 0.01

Problem of Multiple Comparisons
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p < 0.01 p < 10-7



Correction for Multiple Comparisons

• Cluster-based

– Monte Carlo simulation 

– Permutation Tests

– Surface Gaussian Random Fields (GRF) 

• There but not fully tested

• False Discovery Rate (FDR) 
QDEC. (Genovese, et al, NI 2002)

Correction for Multiple Comparisons

Monte Carlo simulation 
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Surface Gaussian Random Fields (GRF) 

There but not fully tested

False Discovery Rate (FDR) – built into tksurfer and 
QDEC. (Genovese, et al, NI 2002)



Clustering
1. Choose a vertex-wise threshold 

• Eg, 2 (p<.01), or 3 (p<.001)

• Sign (pos, neg, abs)

2. A cluster is a group of connected (neighboring) 
vertices above threshold

3. Cluster has a size (area in mm3. Cluster has a size (area in mm

p<.01 (-log10(p)=2)
Negative

p<.0001 (-log10(p)=4)
Negative

Clustering
wise threshold 

Eg, 2 (p<.01), or 3 (p<.001)

A cluster is a group of connected (neighboring) 

Cluster has a size (area in mm2)

34

Cluster has a size (area in mm2)

log10(p)=4)



Cluster-based Correction for Multiple Comparisons

1. Simulate data under Null Hypothesis:
– Synthesize Gaussian noise and then 
– Permute rows of design matrix (Permutation, orthog)

2. Analyze, threshold, cluster, max cluster size
3. Repeat 10,000 times
4. Analyze real data, get cluster sizes4. Analyze real data, get cluster sizes
5. P(cluster) = #MaxClusterSize > ClusterSize/10000

mri_glmfit-sim

based Correction for Multiple Comparisons

Simulate data under Null Hypothesis:
Synthesize Gaussian noise and then smooth (Monte Carlo)
Permute rows of design matrix (Permutation, orthog)

Analyze, threshold, cluster, max cluster size

Analyze real data, get cluster sizes
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Analyze real data, get cluster sizes
P(cluster) = #MaxClusterSize > ClusterSize/10000



Command-line Processing Stages

• Model (X, FSGD) and Contrasts (C)
• Assemble Data (mris_preproc)

• Resample into Common Space
• Concatenate into one file

• Smooth (mri_surf2surf)• Smooth (mri_surf2surf)
• Fit Model (Estimate) (mri_glmfit)
• Correct for multiple comparisons (mri_glmfit
• Visualize (tksurfer)

line Processing Stages

Model (X, FSGD) and Contrasts (C)
Assemble Data (mris_preproc)

Resample into Common Space
Concatenate into one file

36

Fit Model (Estimate) (mri_glmfit)
Correct for multiple comparisons (mri_glmfit-sim)

recon-all -qcache



QDEC – An Interactive Statistical Engine GUI

Query – Select subjects based on Match Criteria
Design – Specify discrete and continuous factors
Estimate – Fit Model
Contrast – Automatically Generate Contrast Matrices

Interactive – Makes easy things easy (that used to be 
hard)

…a work in progress
• No Query yet
• Two Discrete Factors (Two Levels)
• Two Continuous Factors
• Surface only

An Interactive Statistical Engine GUI

Select subjects based on Match Criteria
Specify discrete and continuous factors

Automatically Generate Contrast Matrices
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Makes easy things easy (that used to be 

Two Discrete Factors (Two Levels)



QDEC – Spreadsheet

fsid                        gender     age    diagnosis         Left
011121_vc8048    Female     70     Demented                    202291 
021121_62313-2   Female     71    Demented                     210188 
010607_vc7017    Female     73    Nondemented               170653 
021121_vc10557  Male        75     Demented                     142029 
020718_62545      Male        76     Demented                     186087 

qdec.table.dat – spreadsheet with subject information 

020718_62545      Male        76     Demented                     186087 
020322_vc8817    Male        77      Nondemented              149810 

Female
Male 

gender.levels

Demented 
Nondemented

diagnosis.levels

Spreadsheet

fsid                        gender     age    diagnosis         Left-Cerebral-White-Matter-Vol
011121_vc8048    Female     70     Demented                    202291 

2   Female     71    Demented                     210188 
010607_vc7017    Female     73    Nondemented               170653 
021121_vc10557  Male        75     Demented                     142029 
020718_62545      Male        76     Demented                     186087 

spreadsheet with subject information – spreadsheet can be huge!
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020718_62545      Male        76     Demented                     186087 
020322_vc8817    Male        77      Nondemented              149810 

Discrete Factors need a
factorname.level file



Tutorial

1. Command-line Stream
• Create an FSGD File for a thickness study
• Age and Gender
• Run 

• mris_preproc
• mri_surf2surf • mri_surf2surf 
• mri_glmfit 
• mri_glmfit-sim 
• tksurfer

2. QDEC – same data set

Tutorial

line Stream
Create an FSGD File for a thickness study
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same data set
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Another FSGD Example

GroupDescriptorFile 1
Class MaleRight

• Two Discrete Factors
– Gender: Two Levels (M&F)

– Handedness: Two Levels (L&R)

• One Continuous Variable: Age

Class MaleRight
Class MaleLeft
Class FemaleRight
Class FemaleLeft
Variables                                  Age 
Input bert MaleLeft           10 
Input fred MaleRight         15
Input jenny FemaleRight     20
Input margaret FemaleLeft       25

Another FSGD Example

Handedness: Two Levels (L&R)

One Continuous Variable: Age

41

Variables                                  Age 
MaleLeft           10 
MaleRight         15
FemaleRight     20
FemaleLeft       25 Class = Group



Interaction Contrast
• Two Discrete Factors (no continuous, for now)

– Gender: Two Levels (M&F)

– Handedness: Two Levels (L&R)

• Four Regressors (Offsets)
– MR (b1), ML (b2), FR (b3), FL (

GroupDescriptorFile 1
Class MaleRight
Class MaleLeft
Class FemaleRight
Class FemaleLeft
Input bert MaleLeft
Input fred MaleRight
Input jenny FemaleRight
Input margaret FemaleLeft

Interaction Contrast
Two Discrete Factors (no continuous, for now)

Handedness: Two Levels (L&R)

), FL (b4) R

L

b1

b4

b3

b2

D1

D2
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M F

g = D1 -D2=0
g = (b3-b1)- (b4-b2)

= -b1+b2+ b3-b4

C = [-1 +1 +1 -1]

?



FSGDF

1  0  10 100  1000

1  0  15 150 

DOSS – Different Offset, Same Slope

X =

Male Class

Female Class Age for Males and Females

1  0  15 150 

0  1  20 200 

0  1  25 250 

X =

C =       [-1 1      0       0        0]

#Regressors = Nv+Nc = 3+2=5 
DOF = #Rows - #Regressors

FSGDFX

100  1000

1500

Age for Males and Females

Input:
• y
• X
• C
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1500

2000 

2500 

1 1      0       0        0]

 Fewer regressors than DODS

 Same test, different vector


